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Conseils de sécurité

L’utilisation d’emWave  Pro®  et du logiciel ainsi que des exercices qui 
l’accompagnent doivent vous permettre de trouver un équilibre personnel, 
d’augmenter vos performances et votre niveau de conscience. Bien que 
cet outil et les exercices proposés sont sans danger et peuvent 
potentiellement avoir un effet bénéfique, ils ne se substituent en aucun 
cas à un traitement médical et ne peuvent aucunement induire ou garantir 
une guérison. Ce programme et les exercices associés ne peuvent server 
à des fins médicales ni remplacer un traitement psychologique. 

emWave Pro a été développé dans le but de s’exercer et de se diverter. 
Aucune information ou donnée provenant du mode d’emploi ou du logiciel 
ne peut être utilisée pour établir un diagnostic médical ou psychologique. 

Le schéma de variabilité du rythme cardiaque peut être très différent d’une 
personne à l’autre. Il n’y a pas de “bon” ou de “mauvais” schéma. La valeur 
de cohérence obtenue dans le programme d’entrainement ou lors des jeux 
aide surtout à reconnaitre vos progrès au cours de la pratique de sorte à 
obtenir directement un état de cohérence physiologique. Ne comparez 
jamais vos résultats avec ceux d’une autre personne.

Les personnes souffrant de troubles du rythme cardiaque, comme la 
fibrillation ou flutter auriculaire ou une contraction prématurée auriculaire 
(PAC) ou des extrasystoles ventriculaires (PVC) de même que les enfants 
souffrant d’hyperactivité risquent de ne pas pouvoir utiliser l’emWave Pro 
avec succès. 
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Bienvenue dans le monde de la technologie emWave® 

La technologie brevetée emWave a été mise au point pour vous permettre de gérer 
le stress plus sainement, d’accroître votre résilience et d’améliorer vos performances 
dans tous les domaines de la vie.

La technologie emWave, développée par Doc Childre, est un système d’entraînement 
unique qui se base sur des années de recherche dans le domaine du stress, des 
émotions et de la performance. 

L’emWave Pro mesure votre rythme cardiaque et vous montre votre cohérence 
physiologique. La cohérence est l’équilibre optimal entre le cœur, le cerveau et les 
émotions. Il a été prouvé que cet état est particulièrement bénéfique sur le plan 
mental, physique et émotionnel. Lorsque vous êtes en cohérence, votre système 
immunitaire, votre taux hormonal et votre système nerveux fonctionnent en parfaite 
harmonie physiologique. En pratiquant la technique de Quick Cohérence et d’autres 
techniques proposées par HeartMath vous apprenez à parvenir instantanément dans 
un état de cohérence et vous pourrez observer et expérimenter des changements 
immédiats dans le schéma de votre rythme cardiaque. 
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emWave® Pro: nouvelles fonctions à partir de la v3

HeartCloud

Lorsque vous êtes enregistré dans HeartCloud, vous pouvez télécharger ou synchroniser 
vos séances à partir des différents systèmes HeartMath. Vous disposez ainsi de toutes 
les informations sur le déroulement de vos séances en un coup d’œil et pouvez évaluer 
celles-ci à travers différents graphiques. Vous pourrez y retrouver aussi de nombreuses 
astuces utiles. 

HeartCloud™ est une plateforme récente mise à la disposition des milliers 
d’utilisateurs de HeartMath. HeartCloud offre un accès centralisé à toutes les 
données des séances suivies sur emWave® Pro, emWave®2 et l’application Inner
Balance™, permettant ainsi aux utilisateurs d’améliorer leur expérience avec le 
système de biofeedback et les techniques de cohérence HeartMath.
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Diese beschränkte Garantie deckt nicht das Folgende:

1) QI repariert keine Defekte unter der beschränkten Garantie im Bezug auf Unterhalt, der nicht durch QI
durchgeführt wurde.

2) QI bietet keine Garantie, wenn Ihr Sensor sichtbar manipuliert, falsch gebraucht oder verändert wurde 
wie: Feuchtigkeitsschaden, welcher das korrekte Funktionieren des Sensors stört, Schaden am Gehäuse oder 
sichtbarer Schaden an Kabel oder Konnektor.

3) QI ÜBERNIMMT KEINE HAFTUNG FÜR ZUFÄLLIGE SCHÄDEN, BESONDERE SCHÄDEN UND 
FOLGESCHÄDEN.

Weil manche Staaten, Provinzen und Länder keinen Ausschluss der Haftung für zufällige, besondere oder
Folgeschäden erlauben, ist die oben stehende Beschränkung möglicherweise für Sie nicht gültig.

Ihre Rechte unter impliziten Garantien und lokalem Recht: DIESE BESCHRÄNKTE GARANTIE ERSETZT ALLE 
ANDEREN EXPLIZITEN GARANTIEN, VERPFLICHTUNGEN ODER HAFTUNG. QI BESCHRÄNKT DIE DAUER 
JEDER GARANTIE, BESTIMMT DURCH GESETZE EINES LANDES, STAATES ODER EINER PROVINZ, INKLUSIVE, 
ABER NICHT  BESCHRÄNKT, AUF DIE GENANNTE GARANTIE BETREFFEND VERKÄUFLICHKEIT  UND 
EIGNUNG FÜR BESTIMMTE ZWECKE, AUF EIN JAHR AB DATUM DES ANKAUFS.

Weil gewisse Staaten, Provinzen und Länder gesetzlich keine Beschränkung auf die Dauer einer Garantie 
erlauben, gilt die oben stehende Beschränkung möglicherweise nicht für Sie.

Diese beschränkte Garantie bietet Ihnen gewisse gesetzliche Rechte. Möglicherweise haben Sie auch noch 
andere Rechte, die je nach Staat, Provinz oder Land variieren.

emWave ist eine registrierte Handelsmarke der Quantum Intech, Inc. in den Vereinigten Staaten und 
anderen Ländern. © 2007 Quantum Intech, Inc. Alle Rechte vorbehalten.

Dieser Apparat ist konform mit FCC part 15 class B und CE EN 55.02 und 55.04. 

Getestet für den Gebrauch mit FCC-Normen für Privat- und Betriebsanwendungen.

Produziert unter amerikanischem Patent mit Nummern: 6,358,201; 7,117,032 und 7,163,512. AU Patent Nr.
770323. EU Patent Nr. 1156851. China Patent Nr. 00807109.8. HK Patent Nr. 1042056. Korea Patent Nr.
10-0616370. Kanada Patent Nr. 2,364,032.
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der SOFTWARE. Sie dürfen die SOFTWARE nicht durch „Reverse Engineering“ oder sonst irgendwie 
verändern, umbauen, aufsplitten oder demontieren, außer wenn durch ein anwendbares Recht erlaubt. 
Diese Vereinbarung unterliegt dem Recht des Staates Kalifornien, USA, ohne Rücksicht auf daraus 
resultierende Gesetzes- oder Regelkonflikte.

EmWave Pro SOFTWARE - BESCHRÄNKTE GARANTIE.

QI garantiert, dass die SOFTWARE eine Leistung erfüllt gemäß der zugehörigen gedruckten Dokumentation 
während einer Periode von einem Jahr ab Datum des Kaufs (die beschränkte Garantie). Jede implizite 
Garantie auf die SOFTWARE ist auf ein Jahr beschränkt.

IN MANCHEN STAATEN, PROVINZEN ODER LÄNDERN IST GESETZLICH KEINE BESCHRÄNKUNG DER DAUER 
DER BETREFFENDEN GARANTIE ERLAUBT, WESHALB OBENSTEHENDE BESCHRÄNKUNG MÖGLICHERWEISE
FÜR SIE NICHT ANWENDBAR IST. IN GROSSBRITANNIEN: NICHTS DIESER BESCHRÄNKTEN GARANTIE HAT
EINFLUSS AUF IHRE GESETZLICHEN RECHTE, INKLUSIVE  IHRER EVENTUELLEN  RECHTE GEGENÜBER QI.

LÖSUNGEN FÜR DEN KUNDEN. Die volle Haftung von QI und die für Sie spezifische Lösung mit dem 
Augenmerk auf die beschränkte Garantie wird, nach Wahl von QI, sein: a) Vergütung des Kaufpreises oder 
b) Reparatur oder Ersatz der SOFTWARE, welche nicht durch diese beschränkte Garantie übernommen wird 
und welche an QI mit dem Ankaufbeweis zurückgesandt wird (z. B. Kopie der Zahlungsquittung). Diese 
beschränkte Garantie ist nicht gültig, wenn das Nicht-Funktionieren oder das Schlecht-Funktionieren der 
SOFTWARE zurückzuführen ist auf einen Unfall, falschen Gebrauch oder eine falsche Anwendung. Bei jeder 
ersetzten SOFTWARE ist eine Garantie inbegriffen für die Restzeit der ursprünglichen Garantieperiode oder 
von dreißig (30) Tagen, ausgehend von der längsten Periode.

IN DEN USA UND KANADA: KEINE ANDERE GARANTIE. Innerhalb der maximal erlaubten gesetzlichen 
Grenzen weist QI jede andere Garantie von sich, explizit oder implizit, worunter aber nicht beschränkt auf: 
die betreffende Garantie der Verkäuflichkeit und Eignung für spezifische Zwecke, mit Bezug auf die 
SOFTWARE und die zugehörigen Materialien. Diese beschränkte Garantie bietet Ihnen gewisse Rechte, und 
möglicherweise haben Sie auch andere Rechte, die je nach Staat, Provinz oder Land variieren können.

KEINE HAFTUNG FÜR FOLGESCHÄDEN. Innerhalb der maximal erlaubten Grenzen des anwendbaren Rechts 
wird QI oder ihre jeweiligen Lieferanten in keinem Fall Haftung übernehmen für welchen Schaden auch 
immer, inklusive und ohne Einschränkung: Schaden durch Verlust von Betriebseinkommen, Betriebs-
unterbrechungen, Verlust von Betriebsinformation oder anderer finanzieller Verlust resultierend aus der 
Verwendung oder dem Unvermögen im Gebrauch der SOFTWARE, einer Computerstörung oder -schaden 
oder jeglichen kommerziellen Schaden oder Verlust, selbst, wenn QI oder einer ihrer Lieferanten über die 
Möglichkeit eines solchen Schadens informiert wurden. In diesem Fall wird sich die volle Haftung von QI 
und ihren jeweiligen Lieferanten auf die Vergütung des durch Sie bezahlten Ankaufspreises für die SOFT-
WARE beschränken. Da manche Staaten, Provinzen und Länder gesetzlich die Haftung für Folgeschäden 
und zufälligen Schäden nicht erlauben, trifft oben stehende Beschränkung möglicherweise für Sie nicht zu.

AUSKUNFT. Für Fragen zu dieser Vereinbarung oder zur beschränkten Garantie, oder falls Sie aus einem 
anderen Grund Kontakt mit QI aufnehmen möchten, kontaktieren Sie bitte unsere lokale Agentur: 
HeartMath Deutschland GmbH, Tel.: +49-6805 679 85 30, E-Mail: info@heartmathdeutschland.de.

BESCHRÄNKTE GARANTIE AUF EMWAVE USB-SENSORMODUL UND SENSOR. Basisdeckung:  Das 
Sensormodul und der Sensor haben eine Garantie für den ursprünglichen Besitzer während einer Periode 
von EINEM JAHR ab Datum des ursprünglichen Kaufs für Produktionsfehler von QI – und nicht vom Händler, 
bei welchem der Sensor gekauft wurde. Was QI tut: Weisen das Modul oder der Sensor innerhalb eines 
Jahres Fehler oder Störungen auf, wird das Teil repariert oder durch ein neues oder gründlich 
wiederhergestelltes Teil ersetzt, unter Vorbehalt, dass das defekte Teil mit einer Bezahlung von US $5,00 
für Versand- und Administrationskosten (dies sind keine Reparaturkosten) zurückgesandt wird. Zusätzlich 
verlangt diese Garantie, dass Sie einen Kaufbeleg und das Ankaufdatum beifügen.
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Les données des séances peuvent être facilement échangées dans le HeartCloud, ce 
qui favorise une coopération proactive en équipes, permet de modifier les habitudes et 
améliore les performances. Un système de récompenses (Awards) motive à pratiquer et 
garantit la persévérance dans la pratique des techniques HeartMath. En tant 
qu’utilisateur du HeartCloud, vous pouvez également utiliser les fonctions de rappel 
automatique pour modifier vos réactions émotionnelles au stress de manière encore plus 
ciblée.

Mandala

Vous pouvez démarrer le mandala avant chaque séance ou avant de revoir une séance 
écoulée (menu Exécuter → Repasser la séance HRV).

Calez votre rythme 
respiratoire sur le 
mouvement du 
mandala pour 
augmenter l’équilibre 
interne entre votre 
cœur et vos 
émotions.

Dans les paramètres (menu Editer →Préférences) vous pouvez déterminer si le mandala 
doit apparaître automatiquement au démarrage de la séance (cocher la case „Always  
Open Mandala“).

Remarques importantes :

• Le mandala ne fonctionne pas sur 
les anciens systèmes d’exploitation 
ni sur Windows XP.

• Vous ne pouvez pas faire fonctionner le 
mandala en même temps que le cadenceur 
de respiration (breath pacer).
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Journal

Vous pouvez commenter 
chaque session dans le journal 
d’entraînement (particularités, 
expériences vécues, etc.). 
Grâce au HeartCloud, il vous 
est possible de synchroniser les 
entrées enregistrées dans le 
journal sur tous vos appareils. 
Vous pouvez aussi ajouter, 
modifier ou effacer ces entrées 
dans l’aperçu du journal. 
Utilisez le signe « + » en bas à 
gauche pour ajouter une 
nouvelle entrée. Cliquez 
ensuite sur « entrée » pour 
ajouter du texte et sur le menu 
déroulant du milieu en haut de 
l’écran à côté de « Mood » pour
choisir l’émoticône 
correspondant à votre humeur. 

Menu Fichier

Le menu Import Session n’est plus disponible.
Le menu Import emWave PC n’est plus disponible. 
Export Session utilise un nouveau format de données: *.json.
L’export en données texte est toujours possible au format RR.

Remarque importante : L’export de sessions vers la version 2 d’emWave est également 
possible au format .xml et se trouve sous le menu Edit -> Preferences -> Advanced -> Export 
to v2 Format.

Menu Preferences -> General Tab

Si vous cochez l’option Always Open Mandala, le mandala (voir ci-dessus) démarre 
automatiquement lors du lancement d’une nouvelle session. 

Menu Preferences -> Advanced Tab

Heart Cloud Status: Ce menu permet aux utilisateurs de HeartCloud de se (dé)connecter.
Forgot Password: Menu de réinitialisation du mot de passse du HeartCloud en cas d’oubli.
Menu permettant d’exporter les nouvelles sessions (Version Pro v3) dans la version 

Desktop emWave v2. Cet export utilise le format standard xml et permet aussi de 
convertir les sessions du format 3.x db en format 2.x db.
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und für deren persönlichen Gebrauch auf jedem Computer, der sich in Ihrem Besitz befindet oder welchen 
Sie mieten oder leasen. Falls Sie den Computer mieten oder leasen, stimmen Sie zu, dass Sie die SOFTWARE 
nach Ablauf Ihres Miet- oder Leasingvertrags löschen. Falls Sie eine Organisation oder Betrieb sind, verleiht 
QI Ihnen eine Lizenz für das Installieren der SOFTWARE auf einem Computer innerhalb Ihrer Organisation 
oder Betrieb für den Gebrauch als ein selbst gesteuertes Trainingsprogramm.

Autorisierte Händler dürfen die SOFTWARE verwenden, um das Produkt an mehrere Personen zu 
demonstrieren und um Personen Anweisungen über die Verwendung der SOFTWARE zu geben, dürfen aber 
für diese Vorführungen beim Kunden keine Kosten in Rechnung stellen. Mitarbeiter im Gesundheitswesen 
dürfen die SOFTWARE als Instrument bei ihrer täglichen Arbeit im Gesundheitswesen verwenden. 
Krankenhäuser, Kliniken, Betriebe, Schulen und andere Organisationen dürfen die SOFTWARE auf einem 
öffentlichen Computer für Demonstrationszwecke zur Verfügung stellen, solange für diesen Gebrauch keine 
Kosten in Rechnung gestellt werden.

QI gibt keine Zustimmung für den Gebrauch der registrierten Handelsmarken Quick Cohérence®, Freeze-
Framer® Emotional Management Enhancer, emWave® oder jeglicher anderer Handelsmarke der QI, des 
Institute of HeartMath oder der HeartMath LLC in Werbeäußerungen oder für Marketingzwecke.

(b) Übertragung. Sie dürfen die SOFTWARE-Lizenz dieser Vereinbarung so oft Sie wollen auf einen anderen 
Computer übertragen. Privatpersonen dürfen die SOFTWARE gleichzeitig auf mehreren Computern 
installiert haben, unter dem Vorbehalt, dass alle betreffenden Computer in Ihrem Besitz sind oder durch 
Sie gemietet oder geleast werden. Falls Sie eine Organisation oder Betrieb haben, dürfen Sie die SOFTWARE 
auf einem einzigen Computer für einen einzigen Benutzer installiert haben, es sei denn, dass Sie eine 
Netzwerk-Lizenzvereinbarung unterzeichnet haben, welche die Gültigkeit dieser Vereinbarung ersetzt. Sie 
dürfen die SOFTWARE und die zugehörigen Materialen nicht ohne eine vorhergehende schriftliche 
Zustimmung durch QI mit anderen Produkten vertreiben. Sie dürfen die SOFTWARE nicht vermieten oder 
zum Leasing anbieten, aber Sie dürfen die Rechte dieser Vereinbarung dauerhaft übertragen, unter dem 
Vorbehalt, dass Sie dabei diese SOFTWARE-Lizenzkarte, alle Kopien der SOFTWARE und alle dazugehörigen 
Materialen übertragen und unter Vorbehalt, dass die Partei, an welche Sie übertragen, den Bestimmungen 
dieser Vereinbarung zustimmt. Jede Übertragung der SOFTWARE muss die aktuellste Version und alle 
vorgehenden Versionen der SOFTWARE beinhalten sowie die zugehörigen Materialien.

(c) Kopieren. QI verleiht Ihnen das Recht, identische Kopien des SOFTWAREPRODUKTES auf Ihrem(n) 
Computer(n) zu installieren und zu gebrauchen. Sie dürfen auch Kopien des SOFTWAREPRODUKTES 
machen, falls dies für Back-ups und Archivierungszwecke nötig ist.

(d) Anmerkung für Benutzer. Sie müssen alle Benutzer der SOFTWARE über die Bestimmungen dieser
Vereinbarung informieren.

Im Rahmen dieser Vereinbarung wird unter Verwendung/Benutzung/Gebrauch verstanden: das Laden der 
SOFTWARE auf jegliche Art von Computerspeicher, inklusive RAM, und die Installation auf einer Harddisk 
oder anderem Speicherapparat. Zugang zur SOFTWARE dürfen Sie von einer Harddisk aus, über ein 
Netzwerk oder über jede andere durch Sie gewünschte Methode erhalten, solange Sie dabei die 
Bestimmungen dieser Vereinbarung einhalten.

2. COPYRIGHT. Die SOFTWARE ist Eigentum der QI und ist durch das Urheberrecht der Vereinigten Staaten 
und durch internationale Verträge geschützt. Sie müssen deshalb mit der SOFTWARE wie mit jedem 
anderen urheberrechtlich geschützten Material (wie Büchern oder Musikaufnahmen) umgehen, mit 
Ausnahme, dass Sie die SOFTWARE gemäß dieser Vereinbarung übertragen und kopieren dürfen.

3. PATENT. Es wird kein einziges Recht oder Lizenz verliehen, weder explizit noch implizit, unter welchem 
Patent auch, das ganz oder teilweise Eigentum ist von, unter Lizenz bei oder verwaltet durch QI, mit 
Ausnahme einer Lizenz, die unter einem solchen Patent für die Verwendung der SOFTWARE gemäß dieser 
Vereinbarung verliehen ist.

4. ANDERE EINSCHRÄNKUNGEN. Diese SOFTWARE-Lizenz gilt als Beweis Ihrer Rechte für die Verwendung
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Utilisation, Droits, Brevet, Licences et Garantie
Le système emWave Pro, y compris le materiel, le logiciel et la documentation, est livré avec un numéro 
de licence et ne peut être utilisé ou copié que conformément aux conditions reprises sous la licence. 
Le contenu de cette documentation est fourni à titre d’informations uniquement, peut être changé sans 
préavis et ne doit en aucun cas être interprété comme un engagement de Quantum Intech, Inc. (QI).

Aucun élément de cette publication ne peut, sauf par l’octroi d’une licence, être copié ou dupliqué, 
conservé dans un système de stockage ou transmis à des tiers, sous quelque forme ou de quelque 
manière que ce soit, par voie électronique, mécanique, par enregistrement ou autre sans l’accord 
préalable écrit de QI.

Nous vous rappelons que les illustrations et autres images existantes sont protégées par droit d’auteur. 

Toute utilisation abusive des illustrations ou images enfreint les droits d’auteur. Veil lez à demander 
l’autorisation à l’auteur (aux auteurs) concerné(s). 

emWave, Personal Stress Reliever, Coherence Coach et Emotion Visualizer sont des marques 
enregistrées appartenant à QI. HeartMath est un nom commercial enregistré par l’Institute of HeartMath. 
Quick Coherence est une marque enregistrée par Doc Childre. Pentium est un nom commercial enregistré 
par Intel, Inc. Tous les autres produits ou noms commerciaux sont la propriété de leur auteur. Ecrit et 
développé par Quantum Intech, Inc., 14700 West Park Avenue, Boulder Creek, CA 95006, Etats-Unis, 
Téléphone: +1-831-338-8700; http://www.quantumintech.com; info@quantum- intech.com.

Für Rechtsanwaltskanzleien: limitierte Rechte. Verwendung, Duplikation oder Distribution sind Ein-
schränkungen wie umschrieben im Subparagraph (c)(1)(ii) der Klausel Recht auf technischen Daten und 
Computer-Software von 252.227-7013 unterworfen. Für Zivilrechtskanzleien: Limitierte Rechte. 
Verwendung, Duplikation oder Distribution sind Einschränkungen wie umschrieben im Subparagraph (a) bis 
zu (d) der kommerziellen Klausel unterworfen.

Limitierte Rechte Computer Software von 52.227-19 und die Einschränkung wie im kommerziellen 
Standardvertrag der Quantum Intech beschrieben für diese Software. Unter Vorbehalt der nicht publizierten 
Rechte gemäß den Urheberrechten der amerikanischen Rechtsgebung.

EmWave Pro SOFTWARE LIZENZVEREINBARUNG

SIE DÜRFEN DIE SOFTWARE NICHT INSTALLIEREN ODER VERWENDEN OHNE ZUSTIMMUNG DES BESITZERS 
DER SOFTWARE, DER NUR DANN SEINE ZUSTIMMUNG GIBT, WENN SIE DIE ALLGEMEINEN BEDINGUNGEN 
DIESER VEREINBARUNG AKZEPTIERT HABEN. WENN SIE DIE SOFTWARE INSTALLIEREN ODER AUF EINE 
ANDERE WEISE VERWENDEN, STIMMEN SIE AUTOMATISCH DEN BEDINGUNGEN DIESER VEREINBARUNG 
ZU.

Dies ist eine rechtliche Vereinbarung (die Vereinbarung) zwischen Ihnen (einer Privatperson oder 
Organisation), dem Endverbraucher und Quantum Intech, Inc. (QI). Durch die Verwendung der mitgelieferten 
Software inklusive der zugehörigen Hardware (zusammen die SOFTWARE genannt) stimmen Sie den 
Bedingungen dieser Vereinbarung zu. Falls Sie nicht mit den Bedingungen dieser Vereinbarung einver-
standen sind, senden Sie dieses Paket mit der SOFTWARE, inklusive der zugehörigen Hardware und anderen 
mitgelieferten Materialen, unverzüglich zurück an die Adresse, wo Sie es gekauft haben, um Ihren Ankauf-
betrag zurückzuerhalten.

1. LIZENZBESTIMMUNGEN. Durch diese Vereinbarung verleiht QI Ihnen die folgenden Rechte bezüglich der
Verwendung der SOFTWARE:

(a) Lizenz. Wenn Sie eine Privatperson sind, verleiht QI Ihnen eine Lizenz für das Installieren der SOFTWARE
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Menu View et trois nouveaux aperçus

Cloud
Journal

  Mandala

L’Inspector

Ces trois aperçus peuvent également être
sélectionnés en haut à droite de l’écran
principal :

Les titres et les commentaires des séances ont été remplacés par le Journal. Les textes 
des utilisateurs existants ont été pour la plupart transférés en tant qu’entrées du journal. 

Base de données

Le format de la base de données (database) a subi d’importants changements : Les 
bases de données ancienne version 2.x sont automatiquement mises à jour à 
l’installation de la v3. Si vous avez des bases de données de grande taille, cela peut 
prendre quelques minutes pour que toutes les données soient converties. N’interrompez 
pas le processus de conversion. La nouvelle version de la base de données 3.x ne peut 
pas être ouverte dans les versions emWave 2.x ou 1.x.

Utilisateurs - Users

Lorsque vous créez un nouvel utilisateur (Add User) ou modifiez les données d’un 
utilisateur existant (Edit Current User), il vous est possible de choisir dans la boîte 
de dialogue l’option de connexion et de synchronisation avec le HeartCloud. Il vous 
faudra ensuite entrer l’adresse e-mail de l’utilisateur et définir un mot de passe.
Lorsque vous avez installé emWave2 et emWave Pro sur votre ordinateur, 
emWave2 affichera le nom du dernier utilisateur d’emWave Pro. Ainsi, emWave2 
peut gérer plus d’un utilisateur mais uniquement en connexion avec emWave Pro.
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Premiers pas

A propos de ce mode d’emploi

Ce mode d’emploi est un manuel condensé sur l’application emWave Pro. Il n’est pas 
possible d’y présenter tous les thèmes et toutes les fonctions d’emWave Pro. Vous 
pouvez toutefois trouver de plus amples informations dans le menu d’Aide ou dans le 
Quick Start guide fourni avec le logiciel. Vous pouvez également visiter le centre de 
support Online à l’adresse : http://support.emwave.com.

Contenu de la boîte
CD avec l’application emWave® Pro 
Module d’enregistrement des pulsations
Capteur de pulsation (connecté au module d’enregistrement des pulsations)
Mode d’emploi

Installer le logiciel sur un MAC 
Pour pouvoir installer le programme, il vous faut un numéro d’enregistrement qui se 
trouve sur le dos du mode d’emploi en anglais (Owner’s Manual) joint au CD dans une 
pochette en plastique. Placez le CD dans le lecteur CD-ROM et lancez l’installation de 
l’application.

Double-clic sur l’icône de fichiers emWave 
Le fichier d’installation emWave Pro se trouve dans le premier écran qui apparaît.

Double-clic sur l’icône d’installation emWave 
“Welcome to the emWave Pro Installator“ s’affiche et vous guide tout au long de 
l’installation. 

Cliquez sur “Continue” (= poursuivre)
Veuillez lire l’accord de licence (License Agreement). Lorsque vous cliquez sur Continue, 
une fenêtre s’ouvre pour vous demander si vous souhaitez lire l’accord de licence et 
l’accepter. En cliquant sur Agree (= j’accepte), l’installation se poursuit. 

Par défaut, le programme est installé sous “Macintosh HD”. Cliquez sur Install, pour 
poursuivre. L’„Installator“ vous demande d’entrer votre mot de passe. Cliquez sur OK 
pour continuer. 
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L’Emotion Visualizer®

La fonctionnalité Emotion Visualizer consiste en l’affichage d’images qui évoluent en 
fonction de votre niveau de cohérence. Lorsque vous vous concentrez sur un 
sentiment positif comme la gratitude, la reconnaissance ou l’amour, l’image s’adapte 
à votre niveau de cohérence émotionnel. Ces images dynamiques vous donnent un 
feedback, ce qui vous permet d’augmenter encore votre niveau de conscience quant 
à la manière dont le souvenir de sentiments positifs peut agir sur votre cohérence. 

Pour ouvrir l’Emotion Visualizer, cliquez sur View > Games/Visualizers ou sur le dessin 
du ballon et choisissez l’option Emotion Visualizer.

Cliquez sur le bouton Start de l’Emotion Visualizer pour démarrer une séance. 
Pratiquez en même temps la technique de Quick Cohérence pour renforcer davantage 
votre expérience visuelle.

Pour arrêter votre séance, cliquez soit dans l’écran principal de l’emWave Pro soit
dans la fenêtre de l’Emotion Visualizer. Si nécessaire, il vous est possible de consulter 
la progression de vos données HRV enregistrées. 

Aides supplémentaires                                    
Outils d’aide 
Le programme emWave Pro dispose de nombreux outils d’aide couvrant toutes sortes 
de thèmes dans le détail – ces outils sont disponibles en anglais uniquement. Pour y 
accéder, vous devez cliquer sur Help → emWave Help ou sur le point d’interrogation 
en haut à droite. Il vous est également possible de chercher un thème en particulier 
dans la table des matières par mots-clés ou via la fonction de recherche.

Aide en ligne
L’aide en ligne offre des informations et des réponses détaillées à toutes vos 
questions. Pour accéder à l’aide en ligne, vous devez cliquer sur Help → Online 
Support. Vous pouvez également cliquer sur le symbole du livre en haut à droite. La 
base de connaissances ou la fonction de recherche vous permettent de trouver 
réponse à vos questions.

Remarque : Remplissez le formulaire ci-dessous si vous souhaitez poser une question 
à notre Online Support Center.
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Jouer à un jeu

Cliquez sur le dessin du balon en haut de l’écran de l’emWave Pro. Une page s’ouvre 
vous proposant différents jeux :

Jeu du ballon                       Jeu du jardin                        Jeu de l’arc-en-ciel

Après avoir cliqué sur le jeu souhaité, une nouvelle fenêtre s’ouvre.

Démarrez le jeu en cliquant sur le 
bouton Start en bas de la fenêtre. 
Après avoir calibré le capteur (cela ne 
prend que quelques secondes), le jeu 
démarre dès qu’un des trois voyants 
du niveau de cohérence s’allume. 
Pour arrêter le jeu, cliquez sur le 
bouton Stop en bas au milieu de 
l’écran. 

Pendant que vous jouez, la progression de votre courbe HRV s’enregistre dans l’écran 
principal en arrière-plan. A la fin du jeu, vous pouvez afficher votre séance sur l’écran 
principal ou consulter celle-ci plus tard en cliquant sur „View Progress“ (dessin du 
milieu en haut de l’écran).

Attention : Vous ne pouvez pas ouvrir de jeu en même temps qu’une séance. 
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Suivez les instructions données à l’écran. L’emWave Pro configure votre installation et 
copie les documents nécessaires sur votre ordinateur. Nous conseillons de lire les 
différents menus d’aide et surtout le Quick Start Guide installés sur votre ordinateur une 
fois l’installation terminée. Le Quick Start Guide vous donne les instructions pour installer 
le matériel et démarrer une séance. 

Remarque : à la fin de l’installation, vous serez normalement invité à télécharger les 
mises à jour. Nous vous conseillons vivement d’accepter afin que vous bénéficiiez de la 
dernière version disponible sur votre ordinateur.

Installer le logiciel sur un PC 
Pour pouvoir installer le programme, il vous faut un numéro d’enregistrement qui se 
trouve sur le dos du mode d’emploi en anglais (Owner’s Manual) joint au CD dans une 
pochette en plastique. Placez le CD dans le lecteur CD-ROM et lancez l’installation de 
l’application. 

L’installation ne démarre pas automatiquement
Cliquez sur „Démarrer“ pour accéder au „Bureau“ sur votre ordinateur et double-cliquez 
sur l’icône du lecteur de DVD/CD. 

Double-clic sur le fichier „set up emWave“
Le programme d’installation d’emWave Pro s’ouvre. Cliquez sur Continue (= poursuivre), 
pour démarrer l’installation.
Lisez l’accord de licence (License Agreement). Si vous y adhérez, cliquez sur Agree (= 
j’accepte) et poursuivez l’installation. 

L’“Installer” est un utilitaire convivial qui installe le logiciel en quelques minutes. Nous 
conseillons de lire les différents menus d’aide et surtout le Quick Start Guide installés sur 
votre ordinateur une fois l’installation terminée. Le Quick Start Guide vous donne les 
instructions pour installer le matériel et démarrer une séance.

Remarque : à la fin de l’installation, vous serez normalement invité à télécharger les 
mises à jour. Nous vous conseillons vivement d’accepter afin que vous bénéficiiez de la 
dernière version disponible sur votre ordinateur.
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Lorsque le logiciel est correctement installé, une icône emWave desktop PC s’affiche sur 
votre bureau. Il vous suffit de cliquer sur l’icône pour démarrer l’application.

Enregistrer la licence
Lorsque vous démarrez emWave Pro pour la première fois, il vous est demandé 
d’enregistrer la licence. Votre enregistrement nous permet de vous envoyer les mises à 
jour et autres nouvelles importantes. 

Une fois le numéro de licence entré (vous le trouverez au dos du mode d’emploi anglais), 
vous êtes invité à encoder vos informations utilisateur (= données personnelles). Entrez 
votre nom, votre âge et votre adresse email. emWave Pro démarre et plusieurs fenêtres 
s’ouvrent en même temps. La première concerne la mise à jour d’emWave et vous 
demande si vous souhaitez chercher la version la plus récente du logiciel. La deuxième 
fenêtre est celle de l’Aide emWave Pro qui vous permet de chercher des informations 
classées par thème. La troisième et dernière fenêtre reprend vos données personnelles. 
Toutes ces fenêtres peuvent être fermées si vous n’en avez pas besoin dans l’immédiat. 

Il se peut également qu’une fenêtre s’ouvre pour l’enregistrement en ligne de la licence. 
Il n’est pas obligatoire de remplir cette page pour la garantie. Ces données vont servir à 
vous enregistrer dans la liste de distribution de la Newsletter américaine. Vous pouvez 
fermer cette fenêtre en cliquant sur la croix rouge en haut de la page. 

Enregistrement sur Internet (facultatif)
Veillez à ce que votre ordinateur soit connecté à Internet après installation d’emWave 

Pro.
Ouvrez le menu Help et cliquez sur Register emWave Desktop.

La page Online Product Registration apparaît.
Remplissez le formulaire et cliquez dans le bas de la page sur Create Account pour 

entrer vos données personnelles et terminer l’enregistrement.

Enregistrement par courrier postal (facultatif)
Remplissez la carte fournie avec le logiciel.
Collez un des autocollants reprenant le numéro de licence sur la carte ou écrivez ce 

numéro.
Envoyez la carte par la poste.
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Utilisation du Coherence Coach®

Pour ouvrir le Coherence  Coach, 
cliquez sur le ballon en haut de 
l’écran et parmi les choix qui 
s’affichent, cliquez sur celui du 
Coherence Coach en haut à 
gauche.

Attention :
Lorsqu’une session est en cours, il ne vous est pas possible d’ouvrir le Coherence
Coach ni un des jeux proposés. 

Fixez le capteur au lobe de l’oreille et cliquez sur Play/Stop. Synchronisez votre 
respiration sur le mouvement de la balle. Lorsque vous avez acquis le bon rythme, 
vous pouvez passer à une séance de Quick Coherence, en conservant le rythme 
respiratoire obtenu. Votre courbe HRV apparaît alors sur l’écran principal en arrière-
plan et peut être consultée à tout moment. Dans la barre à gauche du symbole 
Play/Stop, vous pouvez voir votre niveau de cohérence en temps réel. 

Lorsque le senseur est calibré, vous pouvez déplacer le bouton bleu dans la barre en 
bas à droite pour diminuer le volume. La barre en bas à gauche vous permet de la 
même manière de diminuer la vitesse de la balle verte. Suivez les instructions du 
Coach (en anglais).

Pour mettre fin à la séance, cliquez sur Stop, soit dans l’écran principal soit dans la 
fenêtre du Coherence Coach.

Vous pouvez encore consulter la progression de votre HRV dans l’écran principal. 
Celle-ci s’enregistre tout au long de votre séance et offre toutes les fonctionnalités 
d’une séance standard. En cliquant sur le symbole du cœur en haut de l’écran, vous 
pouvez passer à tout moment sur l’écran principal. 
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Power Spectrum (pour utilisateurs avancés)

Vos progrès sont également repris 
sous forme de graphique dans ce 
qu’on appelle le Power Spectrum
(PS).  Pour faire apparaître le PS, 
il faut cliquer sur la petite flèche en 
haut à gauche ou à droite du 
graphique.  Dans le PS de la 
version emWave Pro, la courbe 
HRV est distribuée en différentes 
composantes de fréquence.
Des chercheurs ont ainsi pu démontrer que les barres bleues apparaissant dans les 
trois zones colorées représentent différentes activités du système nerveux autonome.
Le PS nous aide à les identifier.

Le PS se découpe en trois zones : Le champ bleu foncé à gauche reprend les VLF
(très basses fréquences), la zone bleue claire est celle des LF (basses fréquences) et 
la troisième zone à droite reprend les HF (hautes fréquences). Lorsqu’on parle de 
cohérence, l’activité principale se situe aux alentours de 0,1 Hz, c’est-à-dire au centre 
de la zone intermédiaire. C’est ce qui indique la synchronisation de la partie 
sympathique avec la partie parasympathique du système nerveux autonome. 

A la fin d’une séance, vous pouvez observer le PS moyen de l’ensemble de la séance, 
le Spectrum Average. 

Pour obtenir plus d’informations sur le Power Spectrum, vous pouvez cliquer sur le 
menu d’aide en ligne. 
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Installer le matériel
Votre ordinateur doit être allumé, le logiciel emWave Desktop doit être installé et vous 
devez disposer du matériel suivant : le module d’enregistrement USB et le capteur de 
pulsations à clipser à l’oreille.

1. Connexion du module d’enregistrement sur port USB
Connectez le capteur de pulsations au module 
d’enregistrement USB que vous insérez dans un port 
USB libre de votre ordinateur. Une fois pluggé, le 
voyant lumineux du module doit s’allumer brièvement 
pour confirmer la connexion. Ensuite le LED du module 
s’éteint et restera éteint jusqu’à ce que vous démarriez 
une session. 

Le cable du capteur de pulsations doit être bien inséré 
dans le module d’enregistrement USB, c’est-à-dire que 
la fiche du capteur doit être complètement entrée dans
le module. Si le voyant ne s’allume pas, cela signifie que le module n’est pas reconnu. 
Consultez le menu d’aide dans ce cas. 

2. Clipser le capteur de pulsations à l’oreille
Clipsez le capteur au lobe de votre oreille de sorte que cela reste agréable et fixez 
l’attache à votre vêtement, par exemple au col de chemise. Positionnez l’attache le long 
du cable pour que celui-ci ne soit pas trop tendu. Il faut que vous puissiez bouger le 
capteur légèrement sur votre lobe pour permettre une mesure encore plus précise de 
vos pulsations. 

Le capteur doit être directement clipsé au lobe de 
l’oreille. Les mesures sont plus précises lorsque le lobe 
est chaud. Si nécessaire, vous pouvez brièvement 
réchauffer le lobe en le pressant entre le pouce et 
l’index avant de fixer le capteur.

Remarque : il existe également un capteur qui se fixe 
au bout du doigt plutôt que sur le lobe de l’oreille. Vous 
le trouverez dans notre webshop.
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Démarrer une séance
Au début, prenez plusieurs inspirations profondes avant de clipser le 
capteur. Ces inspirations doivent vous permettre de vous détendre et 
d’obtenir un bon enregistrement. Une fois le capteur correctement fixé, 
cliquez sur Start. 
Ensuite, le capteur est calibré et l’écran suivant apparaît :

En bas à gauche, vous pouvez voir vos pulsations (Pulse). Notez que la parole ou le 
mouvement diminuent la précision du capteur.
Lorsque le capteur a été calibré sur vos pulsations, la partie inférieure de l’écran change 
et affiche sur la gauche le score de cohérence cumulé et sur la droite votre résultat de 
cohérence en %.
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Evaluation du résultat de cohérence cumulé
Le résultat de cohérence cumulé – illustré ci-dessus en bleu – dépend de la durée que 
vous avez passée dans un niveau de cohérence faible, moyen ou élevé. 

Lorsque vous vous trouvez dans un état de cohérence faible, la ligne perd du terrain, 
autrement dit va vers le bas. Tandis que lorsque vous vous trouvez dans un niveau de 
cohérence élevé, la ligne remonte. 

Les chiffres à gauche de l’écran correspondent à des points. Pour chaque intervalle 
de 5 secondes que vous passez dans un état de cohérence moyen (bleu), vous 
obtenez un point (+1). Dans un état de cohérence élevé (vert), chaque intervalle 
équivaut à deux points (+2). A l’inverse, un état de cohérence faible (rouge) vous fait 
perdre deux points (-2). 

Lorsque la ligne monte, votre total de points augmente. Lorsqu’elle chute, vos points 
diminuent. 

Dès que votre score atteint plus de 5 points, vous voyez apparaître dans le graphique 
deux lignes obliques qui vont de gauche à droite en remontant. Ces lignes représentent 
une zone cible qui s’appelle The Zone. L’objectif est d’accumuler des points en restant 
dans un niveau de cohérence moyen ou élevé. De cette manière, la ligne bleue évolue 
entre les lignes obliques dans la zone optimale The Zone. 

Sur l’écran affichant le résultat de cohérence cumulé vous pouvez voir à quelle 
distance vous vous trouvez de cette zone. Cela peut vous permettre d’atteindre un 
niveau de cohérence plus élevé. 
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Arrêter et sauvegarder une séance

Pour arrêter la séance, cliquez simplement sur Stop.

La console emWave enregistre automatiquement les données de chaque séance et 
offre la possibilité d’en contrôler les progrès. 

Vous obtenez cet apercu lorsque vous cliquez sur le symbole affichant les trois barres 
d’état en haut au milieu de l’écran. Il vous est possible de revoir une séance enregistrée 
en double-cliquant sur la barre correspondant à une séance précise. 

Chaque utilisateur peut sauvegarder les données dans une base de données 
personnelle. On peut y sauvegarder autant de séances que désiré.

Valeurs de cohérence cumulées
Le résultat de cohérence cumulé
(Cumulated Coherence Score) est un
aperçu linéaire de votre niveau de 
cohérence au cours d’une séance. 
Vous pouvez dès lors mesurer vos 
progrès pendant la séance et les 
comparer à ceux d’une autre séance 
enregistrée.
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Vous obtiendrez de meilleurs résultats lorsque vous êtes calme et ne bougez pas. Si 
vous voyez des lignes rouges (ou artefact) apparaître dans vos pulsations, modifiez la 
position du capteur pour obtenir des vagues lisses et régulières. Lorsque vous bougez
le capteur, il se peut que vous deviez attendre quelques secondes avant que les 
pulsations soient de nouveau visibles à l’écran. Il vous est également possible de faire 
apparaître l’écran montrant vos pulsations en cliquant sur la petite flèche dans le 
graphique en bas à gauche et en sélectionnant Pulse. 

Mesures

Le schéma de votre rythme cardiaque (HRV = la variabilité de la fréquence cardiaque) 
au cours d’une séance vous donne des informations très complètes sur votre condition 
physiologique. Car il vous permet d’obtenir un aperçu des changements permanents 
opérant dans votre système nerveux autonome. Vous pouvez même retirer davantage 
d’informations si vous analysez les points obtenus en cohérence cumulée
(Accumulated Cohérence).

Exemple 1 : schéma HRV régulier et cohérent, proche de l’idéal.
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Dans la plupart des cas, même une personne en bonne condition physiologique 
n’obtiendrait pas un schéma aussi idéal. Au début, le schéma ressemblera plutôt à ceci.

Exemple 2 : Schéma d’un rythme cardiaque incohérent

Lorsque vous pratiquez la technique de cohérence rapide régulièrement, la forme de la 
courbe se modifie. Au départ fort hachurée et incohérente, la courbe suit peu à peu une 
ligne plus lisse et cohérente.

Valeurs de la cohérence
Au cours d’une séance, vous voyez apparaitre à l’écran les valeurs continuellement 
mises à jour de votre cohérence physiologique en %, de votre niveau de cohérence 
présent ainsi que de votre pouls (HR).

Ces informations sont enregistrées sur base de votre variabilité de fréquence cardiaque 
(HRV) et actualisées toutes les cinq secondes. Au niveau du graphique représentant 
votre cohérence cardiaque en % (Coherence Ratios) en bas à droite, les barres 
horizontales de couleur vous indiquent si vous vous trouvez actuellement dans un état 
de cohérence faible (rouge), moyenne (bleu) ou élevée (vert) (= niveau de cohérence 
en temps réel). En fonction du changement d’état, les barres passent du rouge au bleu 
et puis au vert.

Les 3 barres verticales indiquent quant à elles votre cohérence pour toute la durée de 
votre séance. La somme de ces états équivaut toujours à 100%. Les barres du 
graphique des valeurs de cohérence en pourcent montrent combien de temps vous 
avez passé au cours de la séance dans un niveau de cohérence faible, moyen ou élevé. 
L’objectif étant d’augmenter votre niveau de cohérence. Par une pratique régulière avec 
l’emWave Pro, vous parviendrez à rester de plus en plus longtemps dans un état de 
cohérence élevée.

17

Valeurs de cohérence en % (Coherence
Ratios): Selon ce schéma, l’utilisateur était :

37% du temps dans un niveau de 
cohérence faible (Low)

23% du temps dans un niveau de 
cohérence moyenne (Medium)

40% du temps dans un niveau de 
cohérence élevé (High)

Tout au long de la séance, la case de couleur située en dessous de la barre d’état 
indique le niveau de cohérence actuel (ici en vert). Idéalement, vous devriez vous 
trouver 100% du temps dans un niveau de cohérence élevé. 

La fréquence cardiaque enregistrée (Current HR) représente la 
fréquence cardiaque moyenne des 5 dernières secondes écoulées 
de la séance en cours. 

A la fin de la séance, le relevé de fréquence cardiaque indique la 
valeur moyenne de toute la séance (Average HR).

Le graphique sur la gauche reprend les 
valeurs des barres verticales du dessus. 
Les petites ampoules sur la droite 
(Coherence) vous donnent votre niveau de 
cohérence en temps réel. 

Remarque importante : entre l’enregistrement, l’analyse et le rendu du résultat, il peut 
se passer un peu de temps.

Et n’oubliez pas qu’il vous est possible d’améliorer vos valeurs de cohérence en 
pratiquant la technique Quick Coherence®.
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Le résultat de cohérence cumulé
(Cumulated Coherence Score) est un
aperçu linéaire de votre niveau de 
cohérence au cours d’une séance. 
Vous pouvez dès lors mesurer vos 
progrès pendant la séance et les 
comparer à ceux d’une autre séance 
enregistrée.
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Vous obtiendrez de meilleurs résultats lorsque vous êtes calme et ne bougez pas. Si 
vous voyez des lignes rouges (ou artefact) apparaître dans vos pulsations, modifiez la 
position du capteur pour obtenir des vagues lisses et régulières. Lorsque vous bougez
le capteur, il se peut que vous deviez attendre quelques secondes avant que les 
pulsations soient de nouveau visibles à l’écran. Il vous est également possible de faire 
apparaître l’écran montrant vos pulsations en cliquant sur la petite flèche dans le 
graphique en bas à gauche et en sélectionnant Pulse. 

Mesures

Le schéma de votre rythme cardiaque (HRV = la variabilité de la fréquence cardiaque) 
au cours d’une séance vous donne des informations très complètes sur votre condition 
physiologique. Car il vous permet d’obtenir un aperçu des changements permanents 
opérant dans votre système nerveux autonome. Vous pouvez même retirer davantage 
d’informations si vous analysez les points obtenus en cohérence cumulée
(Accumulated Cohérence).

Exemple 1 : schéma HRV régulier et cohérent, proche de l’idéal.
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Démarrer une séance
Au début, prenez plusieurs inspirations profondes avant de clipser le 
capteur. Ces inspirations doivent vous permettre de vous détendre et 
d’obtenir un bon enregistrement. Une fois le capteur correctement fixé, 
cliquez sur Start. 
Ensuite, le capteur est calibré et l’écran suivant apparaît :

En bas à gauche, vous pouvez voir vos pulsations (Pulse). Notez que la parole ou le 
mouvement diminuent la précision du capteur.
Lorsque le capteur a été calibré sur vos pulsations, la partie inférieure de l’écran change 
et affiche sur la gauche le score de cohérence cumulé et sur la droite votre résultat de 
cohérence en %.

19

Evaluation du résultat de cohérence cumulé
Le résultat de cohérence cumulé – illustré ci-dessus en bleu – dépend de la durée que 
vous avez passée dans un niveau de cohérence faible, moyen ou élevé. 

Lorsque vous vous trouvez dans un état de cohérence faible, la ligne perd du terrain, 
autrement dit va vers le bas. Tandis que lorsque vous vous trouvez dans un niveau de 
cohérence élevé, la ligne remonte. 

Les chiffres à gauche de l’écran correspondent à des points. Pour chaque intervalle 
de 5 secondes que vous passez dans un état de cohérence moyen (bleu), vous 
obtenez un point (+1). Dans un état de cohérence élevé (vert), chaque intervalle 
équivaut à deux points (+2). A l’inverse, un état de cohérence faible (rouge) vous fait 
perdre deux points (-2). 

Lorsque la ligne monte, votre total de points augmente. Lorsqu’elle chute, vos points 
diminuent. 

Dès que votre score atteint plus de 5 points, vous voyez apparaître dans le graphique 
deux lignes obliques qui vont de gauche à droite en remontant. Ces lignes représentent 
une zone cible qui s’appelle The Zone. L’objectif est d’accumuler des points en restant 
dans un niveau de cohérence moyen ou élevé. De cette manière, la ligne bleue évolue 
entre les lignes obliques dans la zone optimale The Zone. 

Sur l’écran affichant le résultat de cohérence cumulé vous pouvez voir à quelle 
distance vous vous trouvez de cette zone. Cela peut vous permettre d’atteindre un 
niveau de cohérence plus élevé. 
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Power Spectrum (pour utilisateurs avancés)

Vos progrès sont également repris 
sous forme de graphique dans ce 
qu’on appelle le Power Spectrum
(PS).  Pour faire apparaître le PS, 
il faut cliquer sur la petite flèche en 
haut à gauche ou à droite du 
graphique.  Dans le PS de la 
version emWave Pro, la courbe 
HRV est distribuée en différentes 
composantes de fréquence.
Des chercheurs ont ainsi pu démontrer que les barres bleues apparaissant dans les 
trois zones colorées représentent différentes activités du système nerveux autonome.
Le PS nous aide à les identifier.

Le PS se découpe en trois zones : Le champ bleu foncé à gauche reprend les VLF
(très basses fréquences), la zone bleue claire est celle des LF (basses fréquences) et 
la troisième zone à droite reprend les HF (hautes fréquences). Lorsqu’on parle de 
cohérence, l’activité principale se situe aux alentours de 0,1 Hz, c’est-à-dire au centre 
de la zone intermédiaire. C’est ce qui indique la synchronisation de la partie 
sympathique avec la partie parasympathique du système nerveux autonome. 

A la fin d’une séance, vous pouvez observer le PS moyen de l’ensemble de la séance, 
le Spectrum Average. 

Pour obtenir plus d’informations sur le Power Spectrum, vous pouvez cliquer sur le 
menu d’aide en ligne. 
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Installer le matériel
Votre ordinateur doit être allumé, le logiciel emWave Desktop doit être installé et vous 
devez disposer du matériel suivant : le module d’enregistrement USB et le capteur de 
pulsations à clipser à l’oreille.

1. Connexion du module d’enregistrement sur port USB
Connectez le capteur de pulsations au module 
d’enregistrement USB que vous insérez dans un port 
USB libre de votre ordinateur. Une fois pluggé, le 
voyant lumineux du module doit s’allumer brièvement 
pour confirmer la connexion. Ensuite le LED du module 
s’éteint et restera éteint jusqu’à ce que vous démarriez 
une session. 

Le cable du capteur de pulsations doit être bien inséré 
dans le module d’enregistrement USB, c’est-à-dire que 
la fiche du capteur doit être complètement entrée dans
le module. Si le voyant ne s’allume pas, cela signifie que le module n’est pas reconnu. 
Consultez le menu d’aide dans ce cas. 

2. Clipser le capteur de pulsations à l’oreille
Clipsez le capteur au lobe de votre oreille de sorte que cela reste agréable et fixez 
l’attache à votre vêtement, par exemple au col de chemise. Positionnez l’attache le long 
du cable pour que celui-ci ne soit pas trop tendu. Il faut que vous puissiez bouger le 
capteur légèrement sur votre lobe pour permettre une mesure encore plus précise de 
vos pulsations. 

Le capteur doit être directement clipsé au lobe de 
l’oreille. Les mesures sont plus précises lorsque le lobe 
est chaud. Si nécessaire, vous pouvez brièvement 
réchauffer le lobe en le pressant entre le pouce et 
l’index avant de fixer le capteur.

Remarque : il existe également un capteur qui se fixe 
au bout du doigt plutôt que sur le lobe de l’oreille. Vous 
le trouverez dans notre webshop.
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Lorsque le logiciel est correctement installé, une icône emWave desktop PC s’affiche sur 
votre bureau. Il vous suffit de cliquer sur l’icône pour démarrer l’application.

Enregistrer la licence
Lorsque vous démarrez emWave Pro pour la première fois, il vous est demandé 
d’enregistrer la licence. Votre enregistrement nous permet de vous envoyer les mises à 
jour et autres nouvelles importantes. 

Une fois le numéro de licence entré (vous le trouverez au dos du mode d’emploi anglais), 
vous êtes invité à encoder vos informations utilisateur (= données personnelles). Entrez 
votre nom, votre âge et votre adresse email. emWave Pro démarre et plusieurs fenêtres 
s’ouvrent en même temps. La première concerne la mise à jour d’emWave et vous 
demande si vous souhaitez chercher la version la plus récente du logiciel. La deuxième 
fenêtre est celle de l’Aide emWave Pro qui vous permet de chercher des informations 
classées par thème. La troisième et dernière fenêtre reprend vos données personnelles. 
Toutes ces fenêtres peuvent être fermées si vous n’en avez pas besoin dans l’immédiat. 

Il se peut également qu’une fenêtre s’ouvre pour l’enregistrement en ligne de la licence. 
Il n’est pas obligatoire de remplir cette page pour la garantie. Ces données vont servir à 
vous enregistrer dans la liste de distribution de la Newsletter américaine. Vous pouvez 
fermer cette fenêtre en cliquant sur la croix rouge en haut de la page. 

Enregistrement sur Internet (facultatif)
Veillez à ce que votre ordinateur soit connecté à Internet après installation d’emWave 

Pro.
Ouvrez le menu Help et cliquez sur Register emWave Desktop.

La page Online Product Registration apparaît.
Remplissez le formulaire et cliquez dans le bas de la page sur Create Account pour 

entrer vos données personnelles et terminer l’enregistrement.

Enregistrement par courrier postal (facultatif)
Remplissez la carte fournie avec le logiciel.
Collez un des autocollants reprenant le numéro de licence sur la carte ou écrivez ce 

numéro.
Envoyez la carte par la poste.
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Utilisation du Coherence Coach®

Pour ouvrir le Coherence  Coach, 
cliquez sur le ballon en haut de 
l’écran et parmi les choix qui 
s’affichent, cliquez sur celui du 
Coherence Coach en haut à 
gauche.

Attention :
Lorsqu’une session est en cours, il ne vous est pas possible d’ouvrir le Coherence
Coach ni un des jeux proposés. 

Fixez le capteur au lobe de l’oreille et cliquez sur Play/Stop. Synchronisez votre 
respiration sur le mouvement de la balle. Lorsque vous avez acquis le bon rythme, 
vous pouvez passer à une séance de Quick Coherence, en conservant le rythme 
respiratoire obtenu. Votre courbe HRV apparaît alors sur l’écran principal en arrière-
plan et peut être consultée à tout moment. Dans la barre à gauche du symbole 
Play/Stop, vous pouvez voir votre niveau de cohérence en temps réel. 

Lorsque le senseur est calibré, vous pouvez déplacer le bouton bleu dans la barre en 
bas à droite pour diminuer le volume. La barre en bas à gauche vous permet de la 
même manière de diminuer la vitesse de la balle verte. Suivez les instructions du 
Coach (en anglais).

Pour mettre fin à la séance, cliquez sur Stop, soit dans l’écran principal soit dans la 
fenêtre du Coherence Coach.

Vous pouvez encore consulter la progression de votre HRV dans l’écran principal. 
Celle-ci s’enregistre tout au long de votre séance et offre toutes les fonctionnalités 
d’une séance standard. En cliquant sur le symbole du cœur en haut de l’écran, vous 
pouvez passer à tout moment sur l’écran principal. 
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Jouer à un jeu

Cliquez sur le dessin du balon en haut de l’écran de l’emWave Pro. Une page s’ouvre 
vous proposant différents jeux :

Jeu du ballon                       Jeu du jardin                        Jeu de l’arc-en-ciel

Après avoir cliqué sur le jeu souhaité, une nouvelle fenêtre s’ouvre.

Démarrez le jeu en cliquant sur le 
bouton Start en bas de la fenêtre. 
Après avoir calibré le capteur (cela ne 
prend que quelques secondes), le jeu 
démarre dès qu’un des trois voyants 
du niveau de cohérence s’allume. 
Pour arrêter le jeu, cliquez sur le 
bouton Stop en bas au milieu de 
l’écran. 

Pendant que vous jouez, la progression de votre courbe HRV s’enregistre dans l’écran 
principal en arrière-plan. A la fin du jeu, vous pouvez afficher votre séance sur l’écran 
principal ou consulter celle-ci plus tard en cliquant sur „View Progress“ (dessin du 
milieu en haut de l’écran).

Attention : Vous ne pouvez pas ouvrir de jeu en même temps qu’une séance. 
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Suivez les instructions données à l’écran. L’emWave Pro configure votre installation et 
copie les documents nécessaires sur votre ordinateur. Nous conseillons de lire les 
différents menus d’aide et surtout le Quick Start Guide installés sur votre ordinateur une 
fois l’installation terminée. Le Quick Start Guide vous donne les instructions pour installer 
le matériel et démarrer une séance. 

Remarque : à la fin de l’installation, vous serez normalement invité à télécharger les 
mises à jour. Nous vous conseillons vivement d’accepter afin que vous bénéficiiez de la 
dernière version disponible sur votre ordinateur.

Installer le logiciel sur un PC 
Pour pouvoir installer le programme, il vous faut un numéro d’enregistrement qui se 
trouve sur le dos du mode d’emploi en anglais (Owner’s Manual) joint au CD dans une 
pochette en plastique. Placez le CD dans le lecteur CD-ROM et lancez l’installation de 
l’application. 

L’installation ne démarre pas automatiquement
Cliquez sur „Démarrer“ pour accéder au „Bureau“ sur votre ordinateur et double-cliquez 
sur l’icône du lecteur de DVD/CD. 

Double-clic sur le fichier „set up emWave“
Le programme d’installation d’emWave Pro s’ouvre. Cliquez sur Continue (= poursuivre), 
pour démarrer l’installation.
Lisez l’accord de licence (License Agreement). Si vous y adhérez, cliquez sur Agree (= 
j’accepte) et poursuivez l’installation. 

L’“Installer” est un utilitaire convivial qui installe le logiciel en quelques minutes. Nous 
conseillons de lire les différents menus d’aide et surtout le Quick Start Guide installés sur 
votre ordinateur une fois l’installation terminée. Le Quick Start Guide vous donne les 
instructions pour installer le matériel et démarrer une séance.

Remarque : à la fin de l’installation, vous serez normalement invité à télécharger les 
mises à jour. Nous vous conseillons vivement d’accepter afin que vous bénéficiiez de la 
dernière version disponible sur votre ordinateur.
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Premiers pas

A propos de ce mode d’emploi

Ce mode d’emploi est un manuel condensé sur l’application emWave Pro. Il n’est pas 
possible d’y présenter tous les thèmes et toutes les fonctions d’emWave Pro. Vous 
pouvez toutefois trouver de plus amples informations dans le menu d’Aide ou dans le 
Quick Start guide fourni avec le logiciel. Vous pouvez également visiter le centre de 
support Online à l’adresse : http://support.emwave.com.

Contenu de la boîte
CD avec l’application emWave® Pro 
Module d’enregistrement des pulsations
Capteur de pulsation (connecté au module d’enregistrement des pulsations)
Mode d’emploi

Installer le logiciel sur un MAC 
Pour pouvoir installer le programme, il vous faut un numéro d’enregistrement qui se 
trouve sur le dos du mode d’emploi en anglais (Owner’s Manual) joint au CD dans une 
pochette en plastique. Placez le CD dans le lecteur CD-ROM et lancez l’installation de 
l’application.

Double-clic sur l’icône de fichiers emWave 
Le fichier d’installation emWave Pro se trouve dans le premier écran qui apparaît.

Double-clic sur l’icône d’installation emWave 
“Welcome to the emWave Pro Installator“ s’affiche et vous guide tout au long de 
l’installation. 

Cliquez sur “Continue” (= poursuivre)
Veuillez lire l’accord de licence (License Agreement). Lorsque vous cliquez sur Continue, 
une fenêtre s’ouvre pour vous demander si vous souhaitez lire l’accord de licence et 
l’accepter. En cliquant sur Agree (= j’accepte), l’installation se poursuit. 

Par défaut, le programme est installé sous “Macintosh HD”. Cliquez sur Install, pour 
poursuivre. L’„Installator“ vous demande d’entrer votre mot de passe. Cliquez sur OK 
pour continuer. 
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L’Emotion Visualizer®

La fonctionnalité Emotion Visualizer consiste en l’affichage d’images qui évoluent en 
fonction de votre niveau de cohérence. Lorsque vous vous concentrez sur un 
sentiment positif comme la gratitude, la reconnaissance ou l’amour, l’image s’adapte 
à votre niveau de cohérence émotionnel. Ces images dynamiques vous donnent un 
feedback, ce qui vous permet d’augmenter encore votre niveau de conscience quant 
à la manière dont le souvenir de sentiments positifs peut agir sur votre cohérence. 

Pour ouvrir l’Emotion Visualizer, cliquez sur View > Games/Visualizers ou sur le dessin 
du ballon et choisissez l’option Emotion Visualizer.

Cliquez sur le bouton Start de l’Emotion Visualizer pour démarrer une séance. 
Pratiquez en même temps la technique de Quick Cohérence pour renforcer davantage 
votre expérience visuelle.

Pour arrêter votre séance, cliquez soit dans l’écran principal de l’emWave Pro soit
dans la fenêtre de l’Emotion Visualizer. Si nécessaire, il vous est possible de consulter 
la progression de vos données HRV enregistrées. 

Aides supplémentaires                                    
Outils d’aide 
Le programme emWave Pro dispose de nombreux outils d’aide couvrant toutes sortes 
de thèmes dans le détail – ces outils sont disponibles en anglais uniquement. Pour y 
accéder, vous devez cliquer sur Help → emWave Help ou sur le point d’interrogation 
en haut à droite. Il vous est également possible de chercher un thème en particulier 
dans la table des matières par mots-clés ou via la fonction de recherche.

Aide en ligne
L’aide en ligne offre des informations et des réponses détaillées à toutes vos 
questions. Pour accéder à l’aide en ligne, vous devez cliquer sur Help → Online 
Support. Vous pouvez également cliquer sur le symbole du livre en haut à droite. La 
base de connaissances ou la fonction de recherche vous permettent de trouver 
réponse à vos questions.

Remarque : Remplissez le formulaire ci-dessous si vous souhaitez poser une question 
à notre Online Support Center.
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Utilisation, Droits, Brevet, Licences et Garantie
Le système emWave Pro, y compris le materiel, le logiciel et la documentation, est livré avec un numéro 
de licence et ne peut être utilisé ou copié que conformément aux conditions reprises sous la licence. 
Le contenu de cette documentation est fourni à titre d’informations uniquement, peut être changé sans 
préavis et ne doit en aucun cas être interprété comme un engagement de Quantum Intech, Inc. (QI).

Aucun élément de cette publication ne peut, sauf par l’octroi d’une licence, être copié ou dupliqué, 
conservé dans un système de stockage ou transmis à des tiers, sous quelque forme ou de quelque 
manière que ce soit, par voie électronique, mécanique, par enregistrement ou autre sans l’accord 
préalable écrit de QI.

Nous vous rappelons que les illustrations et autres images existantes sont protégées par droit d’auteur. 

Toute utilisation abusive des illustrations ou images enfreint les droits d’auteur. Veil lez à demander 
l’autorisation à l’auteur (aux auteurs) concerné(s). 

emWave, Personal Stress Reliever, Coherence Coach et Emotion Visualizer sont des marques 
enregistrées appartenant à QI. HeartMath est un nom commercial enregistré par l’Institute of HeartMath. 
Quick Coherence est une marque enregistrée par Doc Childre. Pentium est un nom commercial enregistré 
par Intel, Inc. Tous les autres produits ou noms commerciaux sont la propriété de leur auteur. Ecrit et 
développé par Quantum Intech, Inc., 14700 West Park Avenue, Boulder Creek, CA 95006, Etats-Unis, 
Téléphone: +1-831-338-8700; http://www.quantumintech.com; info@quantum- intech.com.

Für Rechtsanwaltskanzleien: limitierte Rechte. Verwendung, Duplikation oder Distribution sind Ein-
schränkungen wie umschrieben im Subparagraph (c)(1)(ii) der Klausel Recht auf technischen Daten und 
Computer-Software von 252.227-7013 unterworfen. Für Zivilrechtskanzleien: Limitierte Rechte. 
Verwendung, Duplikation oder Distribution sind Einschränkungen wie umschrieben im Subparagraph (a) bis 
zu (d) der kommerziellen Klausel unterworfen.

Limitierte Rechte Computer Software von 52.227-19 und die Einschränkung wie im kommerziellen 
Standardvertrag der Quantum Intech beschrieben für diese Software. Unter Vorbehalt der nicht publizierten 
Rechte gemäß den Urheberrechten der amerikanischen Rechtsgebung.

EmWave Pro SOFTWARE LIZENZVEREINBARUNG

SIE DÜRFEN DIE SOFTWARE NICHT INSTALLIEREN ODER VERWENDEN OHNE ZUSTIMMUNG DES BESITZERS 
DER SOFTWARE, DER NUR DANN SEINE ZUSTIMMUNG GIBT, WENN SIE DIE ALLGEMEINEN BEDINGUNGEN 
DIESER VEREINBARUNG AKZEPTIERT HABEN. WENN SIE DIE SOFTWARE INSTALLIEREN ODER AUF EINE 
ANDERE WEISE VERWENDEN, STIMMEN SIE AUTOMATISCH DEN BEDINGUNGEN DIESER VEREINBARUNG 
ZU.

Dies ist eine rechtliche Vereinbarung (die Vereinbarung) zwischen Ihnen (einer Privatperson oder 
Organisation), dem Endverbraucher und Quantum Intech, Inc. (QI). Durch die Verwendung der mitgelieferten 
Software inklusive der zugehörigen Hardware (zusammen die SOFTWARE genannt) stimmen Sie den 
Bedingungen dieser Vereinbarung zu. Falls Sie nicht mit den Bedingungen dieser Vereinbarung einver-
standen sind, senden Sie dieses Paket mit der SOFTWARE, inklusive der zugehörigen Hardware und anderen 
mitgelieferten Materialen, unverzüglich zurück an die Adresse, wo Sie es gekauft haben, um Ihren Ankauf-
betrag zurückzuerhalten.

1. LIZENZBESTIMMUNGEN. Durch diese Vereinbarung verleiht QI Ihnen die folgenden Rechte bezüglich der
Verwendung der SOFTWARE:

(a) Lizenz. Wenn Sie eine Privatperson sind, verleiht QI Ihnen eine Lizenz für das Installieren der SOFTWARE
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Menu View et trois nouveaux aperçus

Cloud
Journal

  Mandala

L’Inspector

Ces trois aperçus peuvent également être
sélectionnés en haut à droite de l’écran
principal :

Les titres et les commentaires des séances ont été remplacés par le Journal. Les textes 
des utilisateurs existants ont été pour la plupart transférés en tant qu’entrées du journal. 

Base de données

Le format de la base de données (database) a subi d’importants changements : Les 
bases de données ancienne version 2.x sont automatiquement mises à jour à 
l’installation de la v3. Si vous avez des bases de données de grande taille, cela peut 
prendre quelques minutes pour que toutes les données soient converties. N’interrompez 
pas le processus de conversion. La nouvelle version de la base de données 3.x ne peut 
pas être ouverte dans les versions emWave 2.x ou 1.x.

Utilisateurs - Users

Lorsque vous créez un nouvel utilisateur (Add User) ou modifiez les données d’un 
utilisateur existant (Edit Current User), il vous est possible de choisir dans la boîte 
de dialogue l’option de connexion et de synchronisation avec le HeartCloud. Il vous 
faudra ensuite entrer l’adresse e-mail de l’utilisateur et définir un mot de passe.
Lorsque vous avez installé emWave2 et emWave Pro sur votre ordinateur, 
emWave2 affichera le nom du dernier utilisateur d’emWave Pro. Ainsi, emWave2 
peut gérer plus d’un utilisateur mais uniquement en connexion avec emWave Pro.
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Journal

Vous pouvez commenter 
chaque session dans le journal 
d’entraînement (particularités, 
expériences vécues, etc.). 
Grâce au HeartCloud, il vous 
est possible de synchroniser les 
entrées enregistrées dans le 
journal sur tous vos appareils. 
Vous pouvez aussi ajouter, 
modifier ou effacer ces entrées 
dans l’aperçu du journal. 
Utilisez le signe « + » en bas à 
gauche pour ajouter une 
nouvelle entrée. Cliquez 
ensuite sur « entrée » pour 
ajouter du texte et sur le menu 
déroulant du milieu en haut de 
l’écran à côté de « Mood » pour
choisir l’émoticône 
correspondant à votre humeur. 

Menu Fichier

Le menu Import Session n’est plus disponible.
Le menu Import emWave PC n’est plus disponible. 
Export Session utilise un nouveau format de données: *.json.
L’export en données texte est toujours possible au format RR.

Remarque importante : L’export de sessions vers la version 2 d’emWave est également 
possible au format .xml et se trouve sous le menu Edit -> Preferences -> Advanced -> Export 
to v2 Format.

Menu Preferences -> General Tab

Si vous cochez l’option Always Open Mandala, le mandala (voir ci-dessus) démarre 
automatiquement lors du lancement d’une nouvelle session. 

Menu Preferences -> Advanced Tab

Heart Cloud Status: Ce menu permet aux utilisateurs de HeartCloud de se (dé)connecter.
Forgot Password: Menu de réinitialisation du mot de passse du HeartCloud en cas d’oubli.
Menu permettant d’exporter les nouvelles sessions (Version Pro v3) dans la version 

Desktop emWave v2. Cet export utilise le format standard xml et permet aussi de 
convertir les sessions du format 3.x db en format 2.x db.
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und für deren persönlichen Gebrauch auf jedem Computer, der sich in Ihrem Besitz befindet oder welchen 
Sie mieten oder leasen. Falls Sie den Computer mieten oder leasen, stimmen Sie zu, dass Sie die SOFTWARE 
nach Ablauf Ihres Miet- oder Leasingvertrags löschen. Falls Sie eine Organisation oder Betrieb sind, verleiht 
QI Ihnen eine Lizenz für das Installieren der SOFTWARE auf einem Computer innerhalb Ihrer Organisation 
oder Betrieb für den Gebrauch als ein selbst gesteuertes Trainingsprogramm.

Autorisierte Händler dürfen die SOFTWARE verwenden, um das Produkt an mehrere Personen zu 
demonstrieren und um Personen Anweisungen über die Verwendung der SOFTWARE zu geben, dürfen aber 
für diese Vorführungen beim Kunden keine Kosten in Rechnung stellen. Mitarbeiter im Gesundheitswesen 
dürfen die SOFTWARE als Instrument bei ihrer täglichen Arbeit im Gesundheitswesen verwenden. 
Krankenhäuser, Kliniken, Betriebe, Schulen und andere Organisationen dürfen die SOFTWARE auf einem 
öffentlichen Computer für Demonstrationszwecke zur Verfügung stellen, solange für diesen Gebrauch keine 
Kosten in Rechnung gestellt werden.

QI gibt keine Zustimmung für den Gebrauch der registrierten Handelsmarken Quick Cohérence®, Freeze-
Framer® Emotional Management Enhancer, emWave® oder jeglicher anderer Handelsmarke der QI, des 
Institute of HeartMath oder der HeartMath LLC in Werbeäußerungen oder für Marketingzwecke.

(b) Übertragung. Sie dürfen die SOFTWARE-Lizenz dieser Vereinbarung so oft Sie wollen auf einen anderen 
Computer übertragen. Privatpersonen dürfen die SOFTWARE gleichzeitig auf mehreren Computern 
installiert haben, unter dem Vorbehalt, dass alle betreffenden Computer in Ihrem Besitz sind oder durch 
Sie gemietet oder geleast werden. Falls Sie eine Organisation oder Betrieb haben, dürfen Sie die SOFTWARE 
auf einem einzigen Computer für einen einzigen Benutzer installiert haben, es sei denn, dass Sie eine 
Netzwerk-Lizenzvereinbarung unterzeichnet haben, welche die Gültigkeit dieser Vereinbarung ersetzt. Sie 
dürfen die SOFTWARE und die zugehörigen Materialen nicht ohne eine vorhergehende schriftliche 
Zustimmung durch QI mit anderen Produkten vertreiben. Sie dürfen die SOFTWARE nicht vermieten oder 
zum Leasing anbieten, aber Sie dürfen die Rechte dieser Vereinbarung dauerhaft übertragen, unter dem 
Vorbehalt, dass Sie dabei diese SOFTWARE-Lizenzkarte, alle Kopien der SOFTWARE und alle dazugehörigen 
Materialen übertragen und unter Vorbehalt, dass die Partei, an welche Sie übertragen, den Bestimmungen 
dieser Vereinbarung zustimmt. Jede Übertragung der SOFTWARE muss die aktuellste Version und alle 
vorgehenden Versionen der SOFTWARE beinhalten sowie die zugehörigen Materialien.

(c) Kopieren. QI verleiht Ihnen das Recht, identische Kopien des SOFTWAREPRODUKTES auf Ihrem(n) 
Computer(n) zu installieren und zu gebrauchen. Sie dürfen auch Kopien des SOFTWAREPRODUKTES 
machen, falls dies für Back-ups und Archivierungszwecke nötig ist.

(d) Anmerkung für Benutzer. Sie müssen alle Benutzer der SOFTWARE über die Bestimmungen dieser
Vereinbarung informieren.

Im Rahmen dieser Vereinbarung wird unter Verwendung/Benutzung/Gebrauch verstanden: das Laden der 
SOFTWARE auf jegliche Art von Computerspeicher, inklusive RAM, und die Installation auf einer Harddisk 
oder anderem Speicherapparat. Zugang zur SOFTWARE dürfen Sie von einer Harddisk aus, über ein 
Netzwerk oder über jede andere durch Sie gewünschte Methode erhalten, solange Sie dabei die 
Bestimmungen dieser Vereinbarung einhalten.

2. COPYRIGHT. Die SOFTWARE ist Eigentum der QI und ist durch das Urheberrecht der Vereinigten Staaten 
und durch internationale Verträge geschützt. Sie müssen deshalb mit der SOFTWARE wie mit jedem 
anderen urheberrechtlich geschützten Material (wie Büchern oder Musikaufnahmen) umgehen, mit 
Ausnahme, dass Sie die SOFTWARE gemäß dieser Vereinbarung übertragen und kopieren dürfen.

3. PATENT. Es wird kein einziges Recht oder Lizenz verliehen, weder explizit noch implizit, unter welchem 
Patent auch, das ganz oder teilweise Eigentum ist von, unter Lizenz bei oder verwaltet durch QI, mit 
Ausnahme einer Lizenz, die unter einem solchen Patent für die Verwendung der SOFTWARE gemäß dieser 
Vereinbarung verliehen ist.

4. ANDERE EINSCHRÄNKUNGEN. Diese SOFTWARE-Lizenz gilt als Beweis Ihrer Rechte für die Verwendung
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der SOFTWARE. Sie dürfen die SOFTWARE nicht durch „Reverse Engineering“ oder sonst irgendwie 
verändern, umbauen, aufsplitten oder demontieren, außer wenn durch ein anwendbares Recht erlaubt. 
Diese Vereinbarung unterliegt dem Recht des Staates Kalifornien, USA, ohne Rücksicht auf daraus 
resultierende Gesetzes- oder Regelkonflikte.

EmWave Pro SOFTWARE - BESCHRÄNKTE GARANTIE.

QI garantiert, dass die SOFTWARE eine Leistung erfüllt gemäß der zugehörigen gedruckten Dokumentation 
während einer Periode von einem Jahr ab Datum des Kaufs (die beschränkte Garantie). Jede implizite 
Garantie auf die SOFTWARE ist auf ein Jahr beschränkt.

IN MANCHEN STAATEN, PROVINZEN ODER LÄNDERN IST GESETZLICH KEINE BESCHRÄNKUNG DER DAUER 
DER BETREFFENDEN GARANTIE ERLAUBT, WESHALB OBENSTEHENDE BESCHRÄNKUNG MÖGLICHERWEISE
FÜR SIE NICHT ANWENDBAR IST. IN GROSSBRITANNIEN: NICHTS DIESER BESCHRÄNKTEN GARANTIE HAT
EINFLUSS AUF IHRE GESETZLICHEN RECHTE, INKLUSIVE  IHRER EVENTUELLEN  RECHTE GEGENÜBER QI.

LÖSUNGEN FÜR DEN KUNDEN. Die volle Haftung von QI und die für Sie spezifische Lösung mit dem 
Augenmerk auf die beschränkte Garantie wird, nach Wahl von QI, sein: a) Vergütung des Kaufpreises oder 
b) Reparatur oder Ersatz der SOFTWARE, welche nicht durch diese beschränkte Garantie übernommen wird 
und welche an QI mit dem Ankaufbeweis zurückgesandt wird (z. B. Kopie der Zahlungsquittung). Diese 
beschränkte Garantie ist nicht gültig, wenn das Nicht-Funktionieren oder das Schlecht-Funktionieren der 
SOFTWARE zurückzuführen ist auf einen Unfall, falschen Gebrauch oder eine falsche Anwendung. Bei jeder 
ersetzten SOFTWARE ist eine Garantie inbegriffen für die Restzeit der ursprünglichen Garantieperiode oder 
von dreißig (30) Tagen, ausgehend von der längsten Periode.

IN DEN USA UND KANADA: KEINE ANDERE GARANTIE. Innerhalb der maximal erlaubten gesetzlichen 
Grenzen weist QI jede andere Garantie von sich, explizit oder implizit, worunter aber nicht beschränkt auf: 
die betreffende Garantie der Verkäuflichkeit und Eignung für spezifische Zwecke, mit Bezug auf die 
SOFTWARE und die zugehörigen Materialien. Diese beschränkte Garantie bietet Ihnen gewisse Rechte, und 
möglicherweise haben Sie auch andere Rechte, die je nach Staat, Provinz oder Land variieren können.

KEINE HAFTUNG FÜR FOLGESCHÄDEN. Innerhalb der maximal erlaubten Grenzen des anwendbaren Rechts 
wird QI oder ihre jeweiligen Lieferanten in keinem Fall Haftung übernehmen für welchen Schaden auch 
immer, inklusive und ohne Einschränkung: Schaden durch Verlust von Betriebseinkommen, Betriebs-
unterbrechungen, Verlust von Betriebsinformation oder anderer finanzieller Verlust resultierend aus der 
Verwendung oder dem Unvermögen im Gebrauch der SOFTWARE, einer Computerstörung oder -schaden 
oder jeglichen kommerziellen Schaden oder Verlust, selbst, wenn QI oder einer ihrer Lieferanten über die 
Möglichkeit eines solchen Schadens informiert wurden. In diesem Fall wird sich die volle Haftung von QI 
und ihren jeweiligen Lieferanten auf die Vergütung des durch Sie bezahlten Ankaufspreises für die SOFT-
WARE beschränken. Da manche Staaten, Provinzen und Länder gesetzlich die Haftung für Folgeschäden 
und zufälligen Schäden nicht erlauben, trifft oben stehende Beschränkung möglicherweise für Sie nicht zu.

AUSKUNFT. Für Fragen zu dieser Vereinbarung oder zur beschränkten Garantie, oder falls Sie aus einem 
anderen Grund Kontakt mit QI aufnehmen möchten, kontaktieren Sie bitte unsere lokale Agentur: 
HeartMath Deutschland GmbH, Tel.: +49-6805 679 85 30, E-Mail: info@heartmathdeutschland.de.

BESCHRÄNKTE GARANTIE AUF EMWAVE USB-SENSORMODUL UND SENSOR. Basisdeckung:  Das 
Sensormodul und der Sensor haben eine Garantie für den ursprünglichen Besitzer während einer Periode 
von EINEM JAHR ab Datum des ursprünglichen Kaufs für Produktionsfehler von QI – und nicht vom Händler, 
bei welchem der Sensor gekauft wurde. Was QI tut: Weisen das Modul oder der Sensor innerhalb eines 
Jahres Fehler oder Störungen auf, wird das Teil repariert oder durch ein neues oder gründlich 
wiederhergestelltes Teil ersetzt, unter Vorbehalt, dass das defekte Teil mit einer Bezahlung von US $5,00 
für Versand- und Administrationskosten (dies sind keine Reparaturkosten) zurückgesandt wird. Zusätzlich 
verlangt diese Garantie, dass Sie einen Kaufbeleg und das Ankaufdatum beifügen.
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Les données des séances peuvent être facilement échangées dans le HeartCloud, ce 
qui favorise une coopération proactive en équipes, permet de modifier les habitudes et 
améliore les performances. Un système de récompenses (Awards) motive à pratiquer et 
garantit la persévérance dans la pratique des techniques HeartMath. En tant 
qu’utilisateur du HeartCloud, vous pouvez également utiliser les fonctions de rappel 
automatique pour modifier vos réactions émotionnelles au stress de manière encore plus 
ciblée.

Mandala

Vous pouvez démarrer le mandala avant chaque séance ou avant de revoir une séance 
écoulée (menu Exécuter → Repasser la séance HRV).

Calez votre rythme 
respiratoire sur le 
mouvement du 
mandala pour 
augmenter l’équilibre 
interne entre votre 
cœur et vos 
émotions.

Dans les paramètres (menu Editer →Préférences) vous pouvez déterminer si le mandala 
doit apparaître automatiquement au démarrage de la séance (cocher la case „Always  
Open Mandala“).

Remarques importantes :

• Le mandala ne fonctionne pas sur 
les anciens systèmes d’exploitation 
ni sur Windows XP.

• Vous ne pouvez pas faire fonctionner le 
mandala en même temps que le cadenceur 
de respiration (breath pacer).
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emWave® Pro: nouvelles fonctions à partir de la v3

HeartCloud

Lorsque vous êtes enregistré dans HeartCloud, vous pouvez télécharger ou synchroniser 
vos séances à partir des différents systèmes HeartMath. Vous disposez ainsi de toutes 
les informations sur le déroulement de vos séances en un coup d’œil et pouvez évaluer 
celles-ci à travers différents graphiques. Vous pourrez y retrouver aussi de nombreuses 
astuces utiles. 

HeartCloud™ est une plateforme récente mise à la disposition des milliers 
d’utilisateurs de HeartMath. HeartCloud offre un accès centralisé à toutes les 
données des séances suivies sur emWave® Pro, emWave®2 et l’application Inner
Balance™, permettant ainsi aux utilisateurs d’améliorer leur expérience avec le 
système de biofeedback et les techniques de cohérence HeartMath.
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Diese beschränkte Garantie deckt nicht das Folgende:

1) QI repariert keine Defekte unter der beschränkten Garantie im Bezug auf Unterhalt, der nicht durch QI
durchgeführt wurde.

2) QI bietet keine Garantie, wenn Ihr Sensor sichtbar manipuliert, falsch gebraucht oder verändert wurde 
wie: Feuchtigkeitsschaden, welcher das korrekte Funktionieren des Sensors stört, Schaden am Gehäuse oder 
sichtbarer Schaden an Kabel oder Konnektor.

3) QI ÜBERNIMMT KEINE HAFTUNG FÜR ZUFÄLLIGE SCHÄDEN, BESONDERE SCHÄDEN UND 
FOLGESCHÄDEN.

Weil manche Staaten, Provinzen und Länder keinen Ausschluss der Haftung für zufällige, besondere oder
Folgeschäden erlauben, ist die oben stehende Beschränkung möglicherweise für Sie nicht gültig.

Ihre Rechte unter impliziten Garantien und lokalem Recht: DIESE BESCHRÄNKTE GARANTIE ERSETZT ALLE 
ANDEREN EXPLIZITEN GARANTIEN, VERPFLICHTUNGEN ODER HAFTUNG. QI BESCHRÄNKT DIE DAUER 
JEDER GARANTIE, BESTIMMT DURCH GESETZE EINES LANDES, STAATES ODER EINER PROVINZ, INKLUSIVE, 
ABER NICHT  BESCHRÄNKT, AUF DIE GENANNTE GARANTIE BETREFFEND VERKÄUFLICHKEIT  UND 
EIGNUNG FÜR BESTIMMTE ZWECKE, AUF EIN JAHR AB DATUM DES ANKAUFS.

Weil gewisse Staaten, Provinzen und Länder gesetzlich keine Beschränkung auf die Dauer einer Garantie 
erlauben, gilt die oben stehende Beschränkung möglicherweise nicht für Sie.

Diese beschränkte Garantie bietet Ihnen gewisse gesetzliche Rechte. Möglicherweise haben Sie auch noch 
andere Rechte, die je nach Staat, Provinz oder Land variieren.

emWave ist eine registrierte Handelsmarke der Quantum Intech, Inc. in den Vereinigten Staaten und 
anderen Ländern. © 2007 Quantum Intech, Inc. Alle Rechte vorbehalten.

Dieser Apparat ist konform mit FCC part 15 class B und CE EN 55.02 und 55.04. 

Getestet für den Gebrauch mit FCC-Normen für Privat- und Betriebsanwendungen.

Produziert unter amerikanischem Patent mit Nummern: 6,358,201; 7,117,032 und 7,163,512. AU Patent Nr.
770323. EU Patent Nr. 1156851. China Patent Nr. 00807109.8. HK Patent Nr. 1042056. Korea Patent Nr.
10-0616370. Kanada Patent Nr. 2,364,032.
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Conseils de sécurité

L’utilisation d’emWave  Pro®  et du logiciel ainsi que des exercices qui 
l’accompagnent doivent vous permettre de trouver un équilibre personnel, 
d’augmenter vos performances et votre niveau de conscience. Bien que 
cet outil et les exercices proposés sont sans danger et peuvent 
potentiellement avoir un effet bénéfique, ils ne se substituent en aucun 
cas à un traitement médical et ne peuvent aucunement induire ou garantir 
une guérison. Ce programme et les exercices associés ne peuvent server 
à des fins médicales ni remplacer un traitement psychologique. 

emWave Pro a été développé dans le but de s’exercer et de se diverter. 
Aucune information ou donnée provenant du mode d’emploi ou du logiciel 
ne peut être utilisée pour établir un diagnostic médical ou psychologique. 

Le schéma de variabilité du rythme cardiaque peut être très différent d’une 
personne à l’autre. Il n’y a pas de “bon” ou de “mauvais” schéma. La valeur 
de cohérence obtenue dans le programme d’entrainement ou lors des jeux 
aide surtout à reconnaitre vos progrès au cours de la pratique de sorte à 
obtenir directement un état de cohérence physiologique. Ne comparez 
jamais vos résultats avec ceux d’une autre personne.

Les personnes souffrant de troubles du rythme cardiaque, comme la 
fibrillation ou flutter auriculaire ou une contraction prématurée auriculaire 
(PAC) ou des extrasystoles ventriculaires (PVC) de même que les enfants 
souffrant d’hyperactivité risquent de ne pas pouvoir utiliser l’emWave Pro 
avec succès. 
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Bienvenue dans le monde de la technologie emWave® 

La technologie brevetée emWave a été mise au point pour vous permettre de gérer 
le stress plus sainement, d’accroître votre résilience et d’améliorer vos performances 
dans tous les domaines de la vie.

La technologie emWave, développée par Doc Childre, est un système d’entraînement 
unique qui se base sur des années de recherche dans le domaine du stress, des 
émotions et de la performance. 

L’emWave Pro mesure votre rythme cardiaque et vous montre votre cohérence 
physiologique. La cohérence est l’équilibre optimal entre le cœur, le cerveau et les 
émotions. Il a été prouvé que cet état est particulièrement bénéfique sur le plan 
mental, physique et émotionnel. Lorsque vous êtes en cohérence, votre système 
immunitaire, votre taux hormonal et votre système nerveux fonctionnent en parfaite 
harmonie physiologique. En pratiquant la technique de Quick Cohérence et d’autres 
techniques proposées par HeartMath vous apprenez à parvenir instantanément dans 
un état de cohérence et vous pourrez observer et expérimenter des changements 
immédiats dans le schéma de votre rythme cardiaque. 
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